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Introduction 

Audience 
The audience for this manual includes station engineers or technicians working for content 
creators or third-party providers.  

Note Media distributors are required to actively encode using the Nielsen encoding 
methodology per their service agreements with Nielsen. 

Customer Support 
Nielsen Support Location 

Nielsen Encoder Support 800-537-4872 option 2 

Encoders@nielsen.com 

Support Request (form) http://nielsen-encoder-
forum.com/public/documentation/ 

Nielsen Encoder Forum www.nielsen-encoder-forum.com/public/ 

Nielsen Global Technology Center Nielsen 

501 Brooker Creek Blvd 

Oldsmar, FL 34677 

www.nielsen.com 

Conventions Used in this Document 
The following items appear in this document:  

Note This paragraph flags a key point, indicates a tip, or identifies an alternate way of 
performing a task. 

Important This paragraph emphasizes one or more actions that must be followed to avoid a 
catastrophic failure. 

Related Documents 
CableLabs VOD Content Encoding Profiles Specification—specification for encoding AC-3 
files 

CableLabs VOD Metadata Specification Version 1.1—specification for providing metadata for 
AC-3 files 

VOD Encoder Installation Quick Start—procedures for installing the encoder applications 
products 

mailto:Encoders@nielsen.com
http://nielsen-encoder-forum.com/public/documentation/
http://nielsen-encoder-forum.com/public/documentation/
http://www.nielsen-encoder-forum.com/public/
http://www.nielsen.com/
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Understanding Encoding and Transferring Metadata 

VOD Content Encoding 
The VOD Content Encoder (the Encoder) watermarks audio content of a VOD (Video on 
Demand) asset. In a nutshell, the Encoder reads input from an audio file, generates an 
encoded file, and sends metadata to the Nielsen Collection Facility (CF): 

Note The Encoder refers to the package that includes the SID/TIC Drive, VOD Content Encoder 
application, and SID/TIC Installer application. 

Metering equipment that resides in Nielsen panelists’ homes captures these audio codes 
(also called watermarks) from television viewing and sends them to the CF, where back-end 
systems use them to credit viewing. 

The Encoder watermarks audio in these transport streams: 

Table 1 – Supported Audio Transport Streams 

MPEG-2 Stream in Format With Extensions: 

PCM *.mpg, 

*.m2t 

*.trp 

*.ts 

AC3 

 

The watermark consists of a unique SID (source identifier) and a number referred to as a TIC 
(time-in-content). The Encoder inserts either or both of two types of unique SID/TIC pairs: 

• NAES II—Nielsen Audio Encoder System II, the second-generation method of inserting a 
SID (Nielsen source identifier) and time stamp into a TV signal 

• NW—Nielsen Watermarks, a newer method of audio encoding that places an audio 
watermark in a lower-frequency portion of the active program than does NAES II 
technology. Its lower-frequency position enables NW to be more robust and much less 
likely to be “compressed out” of the program audio by TV distribution. 

As individual VOD files are watermarked, the Encoder generates a metadata feed-point file 
and other files that are transmitted to the Nielsen Collection Facility (CF): 

• Metadata feed-point file—contains information Nielsen uses to uniquely identify the VOD 
asset. The metadata file contains the SID, a range of TICs, asset ID, and information 
about the VOD content. The metadata file is copied, renamed <SID>_<TIC>_nmr.xml, 
and moved to a transfer folder before it is transferred to the CF. 

• CableLabs ADI.xml file (optional)—may be attached for VOD content compliant with 
CableLabs standard (AC-3 audio). The ADI.xml file, which the provider supplies and is 
distributed to cable head-ends, must conform to CableLabs® Asset Distribution Interface 
Specification Version 1.1. 
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Components of the VOD Content Encoder 
The VOD Content Encoder consists of the following the components: 

• SID/TIC Drive Installer—an application that detects and installs a SID/TIC Drive on a 
system 

• SID/TIC Drive (the Drive)—a USB flash drive that is pre-configured with client-specific 
information. Each system hosting a Server must have access to the Drive. The Drive can 
be inserted into a USB port on the same computer or into the port of a computer on the 
same network that uses TCP/IP communication. The Drive contains a serial number, a 
database of SID/TIC pairs, and a database of DSID/Distribution Source Name entries.  

o SID—a numeric value assigned by Nielsen to individual content providers. 

o TIC—a 32-bit counter that increments once per second of the encoded content. 
The TIC value represents the next available starting TIC for the SID in question. 
With each client request, the Server application caches (and later reserves) the 
value of the TIC at the start of the transaction, then updates the value of the TIC 
stored in the database by adding to it the number of TICs to reserve. 

Ensuring TIC uniqueness for each SID is critical to proper crediting of viewing. 
The Server ensures that TICs are not duplicated. If an Encoder asks the Server 
to process a SID that does not already exist in its databases, the client’s request 
fails, and the Server responds with an error string. 

• SID/TIC Server (the Server)—an application that maintains mirror databases on the 
Server host computer and the Drive. Before responding to any Encoder request and, for 
almost any transaction, the Server first verifies all databases are present and identical. 
The Server runs as a service that automatically starts when the computer hosting it 
boots. A VOD Discovery Service “listens” on a port for “discovery” requests from the 
Encoder. 

The Server allows only one connection at a time, completely processing each request 
before servicing the next. Since the processing of a request requires only a fraction of a 
second, the serialization of processing should not be a problem, even in the busiest 
encoding facility. If more than one Server is configured, each Server allocates a different 
range of SID/TICs. 

• VOD Content Encoder software—an application that encodes, decodes, and can send 
metadata files directly to the CF or to another computer in your facility for forwarding to 
the CF. The application can be run from a graphical user interface, a command-line tool, 
(ContentCodeCmd), or a file trigger service. 

• File Transfer Manager—optional software used to send metadata files to the CF from a 
system without the Encoder installed. At scheduled times, the File Transfer Manager 
Service transfers data to the CF. If the connection is disrupted, the manager or service 
automatically retries to send the data. For batch file encoding, you must install the File 
Transfer Manager. 

ServicesMonitorTool—an application that monitors all services. If a metadata file transfer to 
the CF fails, the tool displays a notification message and restarts stopped services. 
ServicesMonitorTool is automatically installed with the VOD Content Encoder software, File 
Transfer Manager Software, and SID/TIC server. The user can configure which services are 
monitored and whether or not the notification message appears. For details, see “Configuring 
the ServicesMonitorTool” on page 47. 
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Transferring Metadata to the Nielsen Collection Facility 

Overview of the File Transfer Options 
To receive credited viewing, the feed-point metadata files that correspond with the encoded 
files must be sent to the CF. You can send these files directly or indirectly to the CF using 
one of several options. See also the workflows that begin on page 25. 

• Directly transfer to data collection facility—the Nielsen File Transfer Manager Service 
uses SSH (Secure Shell software) to directly send files from the Encoder to the CF. 

• Transfer files to a local sever—the Encoder uses the FTP function that is included in the 
VOD Encoder application or a third-party FTP application to transfer files to a transfer 
server and then the Nielsen File Transfer Service sends the files to the CF. 

Important Install or enable only one FTP application on a computer. 

In addition to these transfer flows, there are different configurations that you can use: 

• Manually sending the metadata files  

• Using the File Trigger Service to automatically send the metadata files 

• Creating tar files and manually or automatically sending the tar files that contain the 
metadata files and corresponding ADI files 

Important To use the tar file method, the files must conform to CableLabs® Asset 
Distribution Interface Specification Version 1.1. 

The encoder sends the metadata in Table 2 in a file to the CF: 

Table 2 – Feed-Point Metadata File Contents 

Field Description Comment 

ADIFileName Name of the CableLabs file (if 
any) that is transferred to the 
CF with the Feed-Point 
Metadata file.  

Optional 

Note ADI files are created by 
applications not under the 
control of Nielsen, therefore, 
we cannot guarantee that the 
ADI file is well formed. 

ProviderId ID of the content provider May be derived from a Provider ID 
field in the CableLabs file 

Provider Name of the content provider May be derived from a Provider field in 
the CableLabs file 

AssetId ID of the encoded content May be derived from an Asset ID field 
in the CableLabs file 

AssetName Name of the encoded content May be derived from an Asset Name 
field in the CableLabs file 

EpisodeId Unique identifier given to each 
episode of a given series 

String characters, such as Episode 
#45 (may be derived from an Asset 
Name field in the CableLabs file) 
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Field Description Comment 

OriginatorId Unique Nielsen number to link 
back to the content provider. 

 

WatermarkTime The actual system time that the 
watermarking process started, 
expressed as UTC 
(Coordinated Universal Time). 

 

SID Value of the SID that was 
inserted into this asset 

 

StartingTIC Value of first TIC presented to 
the watermarking algorithm for 
insertion into the asset.  

First TIC (it may be significantly offset 
from the AllocatedStartTIC, depending 
upon the location in the stream of the 
first frame of audio) 

EndingTIC Value of the last TIC that the 
encoder presented to the 
watermarking algorithm for 
insertion into the asset 

Last TIC (may be significantly less 
than the value of the AllocatedEndTIC, 
depending upon the location in the 
stream of the last frame of audio) 

AllocatedStartTIC Value of the first TIC reserved—
and the first TIC presented to 
the watermarking algorithm for 
insertion into the asset. 

 

AllocatedEndTIC Value of the last TIC reserved 
for this asset 

 

HDContent True if and only if content is 
high definition.  

Not currently used (undefined) 

FileSizeBytes Size of the encoded file in bytes  

FileSizeSeconds Approximate duration (in 
seconds) of the encoded file 
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Methods of Transferring Metadata 
There are a few different methods for transferring metadata files to the CF. 

• VOD Content Encoder application—if you are directly transferring files from the computer 
that does the encoding to the Nielsen CF, you configure the File Transfer Manager from 
within the VOD Content Encoder application itself. 

• File Transfer Manager application (FTM)—if the File Transfer Manager application is on a 
different computer from the VOD Content Encoder application, you can use the FTM 
application to transfer the metadata files to the CF. See “Transferring Files Using the File 
Transfer Manager” on page on page 38. 

• File Trigger Service—use this tool to do the following: 

o Manually start or stop file transfers from an internal server to the CF. See 
“Configuring the Trigger Service to Run Manually” on page 29. 

o Automatically encode tar files and transfer data to the CF. See “Configuring the 
File Trigger Service to Run Automatically” on page 29. 

The next section gives more details on how the File Trigger Service works. 

File Trigger Service 

Overview 
The File Trigger Service (the Trigger Service) performs content-based encoding according to 
parameters defined in a standard XML file (see Table 3 for the parameters and the Appendix 
for the format).  

1. The Trigger Service opens C:/Program Files/Nielsen/etc/EncoderConfig.txt file. See 
Figure 9 – Encoder Configuration (System Setup) Window on page 24 for details on 
setting these parameters. 

2. The Trigger Service extracts the following two settings entered into the 
FileTriggerManager window. See Figure 16 – File Trigger Manager Window on page 
29. 

o XML File Path—the path to the EncoderParamFolder, which is the extracted path 
name and is sometimes referred to as the encoder parameter folder. 

o Scratch Folder setting, used in the optional tar-file processing 

3. From the EncoderConfig.txt file, the Trigger Service extracts the SID/TIC Server IP 
address and all other configuration settings directly related to content-based 
encoding. 

4. The Trigger Service repeatedly checks EncodeParamFolder, searching for all files 
that have the extension “xml.” 

5. The Trigger Service makes a list of those xml files and processes the xml files, one at 
a time, as follows: 

a. Opens the xml file 

b. Reads the file 

c. Validates all encoder parameter settings in the file 
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d. (Optional) If it detects a TarFilePath, the system performs a tar-file encode. See 
“Using the File Trigger Service with Tar Files” on page on page 12. 

e. Closes the file. See Table 3 for a complete listing of settings that may be 
extracted from the xml file. 

6. It encodes the specified video source file, using the settings extracted from the xml 
file as its encoding parameters. It uses the same encoding process (including 
interacting with the SID/TIC server, creating and naming metadata files, logging 
status and errors) that the VOD Content Encoder application uses. 

7. When the source file has been encoded successfully, the Trigger Service deletes the 
corresponding xml file from the drive. 

8. The Trigger Service sends the files to the Nielsen CF. 

9. When all files in the xml list are fully encoded, the Trigger Service repeats steps 4 
and 5. 

10. The Trigger Service runs until it is manually stopped. 

Standard XML File Parameters 
Table 3 – Parameters Defined for Standard XML File-Encoding 

XML Label 
Parameter 
Data Type Parameter Usage 

InputFile char * Full path name of the source video file. 

OutputFile char * Full path name of the encoded video file that the 
File-Trigger encoder creates. 

AdiFile char * (Optional) full path name of the folder that holds 
CableLabs ADI Asset Distribution Interface. files 

SID int The SID to be used in the upcoming encoding 
session. 

AssetId char * The asset ID to be reported in the metadata file 
for the clip that is about to be encoded. 

AssetName char * The asset name to be reported in the metadata 
file for the clip that is about to be encoded. 

EpisodeId char * The optional episode ID to be written to the 
feed-point metadata file. If the episode ID is not 
found in the trigger file An XML file whose 
appearance in a specific folder triggers the start 
of a VOD-content encode. The path where these 
trigger files are located is identified by the 
"EncoderParamFolder" setting in the 
EncoderConfig.txt file in the VOD ROOT / etc 
folder. , it may be read from the ADI XML file. 

javascript:kadovTextPopup(this)
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Using the File Trigger Service with Tar Files 
The Trigger Service can be configured to process a tar file that was created according to 
CableLabs standards. A CableLabs tar file contains, at a minimum: 

• The MPEG file to be encoded 

• An ADI XML file that describes the contents of the MPEG file. 

Content providers use devices such as the Tandberg encoder to create the tar files. Once the 
tar files are assembled, they can be "pitched" to facilities ("catchers") that extract the archived 
files, and then make the MPEG content available for viewing. 

The Trigger Service extracts the contents of the tar file (MPEG and ADI XML files), encodes 
the MPEG file, updates the ADI XML file, and archives the content into a new tar file. The 
content provider pitches the newly created tar file. See “Format of a Tar File Trigger File” on 
page 66. 

Table 4 defines the parameters in the tar file. 

Table 4 – Tar File Parameters 

 

XML Label 
Parameter 
Data Type Parameter Usage 

TarFilePath char * Full path name of the folder where the to-be-
processed tar file is located 

TarFileName char * Name of the tar file to be processed 

NewTarFilePath char * Full path name of the folder where the newly 
created tar file is placed 

NewTarFile Name char* Name of the newly created tar file 

Note This file name can be the same as the 
TarFileName as long as TarFilePath 
and NewTarFilePath are different. 

SID Int SID to be used in the upcoming encoding 
session. 

EpisodeId char * The optional episode ID to be written to the feed-
point metadata file. If the episode ID is not found 
in the trigger file it may be read from the ADI 
XML file. 
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Tar-File Constraints / Assumptions / Considerations 
Note See also “Transferring Files Using the File Trigger Service” on page 38. 

When the Trigger Service is processing tar files, the following constraints apply: 

• It is assumed that the ADI file extracted from the tar file is named ADI.XML (the filename 
is not case-sensitive). If the Trigger Service does not locate the ADI file among the files in 
the tar file, the encoding process fails. 

• Except for episode ID, all fields in Table 4 are required fields. It is assumed that tar file 
path names identify valid paths that have already been created. It is also assumed that 
the tar file folders are large enough to hold all of the tar files. 

• The asset name and asset ID of the "movie" asset (in the ADI.xml file) are applied to the 
feed-point metadata file. 

Note  Although the asset name and asset ID of the "title" asset may be similar, it is the "movie" 
asset that is used. 

• The MPEG file name is taken from the "Content" node of the ADI.xml file. The content 
node appears in the ADI file as <Content Value="MPEG file name"/>. 

• The original ADI file must contain a checksum node. 

Tar File Processing Overview 
When it carries out tar-file processing, the VOD File Trigger Service works as follows: 

1. It opens the trigger file. 

2. If it detects the “EncoderParamFolder” setting in the ADI.XML file, it switches to tar-
file encoding mode. 

3. From the trigger file, the Trigger Service extracts: 

o The name of the tar file to use in encoding 

o The path name of the tar file to use in encoding 

o The name of the tar file to create after each successful encode. 

o The path name of the folder where the newly created tar file is to be placed. 

o The SID to use in watermarking 

o (Optional) the episode ID to be written to the feed-point metadata file. If not 
provided by the trigger file, the episode ID may be read from the ADI.XML file or 
it may be left blank. 

4. From the C:\Program Files\Nielsen\etc\EncoderConfig.txt file, the Trigger Service 
extracts: 

o The SID/TIC server address 

o The discovery port (if the server address contains at least one part set to “255.” 

o The full path name of the folder that holds the trigger files.  

o The full path name of the scratch folder. 

o Other standard encoding parameters. 

5. After reading the trigger file and the encoder configuration file, the service extracts 
into the scratch folder the contents of the tar file. 
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6. After changing directories to the scratch folder, the service opens and reads the 
ADI.XML file, extracting from it: 

o The name of the MPEG file to be encoded 

o The asset ID (of the “movie” asset) 

o The asset name (of the “movie” asset) 

o The episode ID (optional) 

7. The Trigger Service passes the settings extracted from the trigger file, the 
configuration file, and the ADI file to the encoder object. It content-encodes the 
MPEG file in compliance with the extracted settings. It creates the name of the 
encoded file by adding the string “_n2” to the base name of the original MPEG file. 
The newly encoded file is created in the scratch folder. 

8. The service deletes the original MPEG file. 

9. If the encoding process was successful, the service does the following: 

o Modifies the name of the MPEG file in the ADI.XML folder to reference the newly 
created file instead of the original MPEG file. 

o Calculates the MD-5 checksum of the newly encoded file, replacing the original 
checksum in the ADI_XML folder with the newly calculated checksum. 

o Creates a new tar file by archiving all files in the scratch folder into a new tar file. 
In naming and placing the new tar file, the service uses the “new” tar file name 
and “new” tar file path parsed earlier from the trigger file. 

o Deletes all files from the scratch folder. 

10. The status of the encoding process is logged in EncodedFileLog.txt file (in 
C:\Program Files\Nielsen\log). Each line starts with an S for success or an F for 
failure, followed by the name of the trigger file processed. 

11. If the entire process was successful, the service deletes the trigger file. 

Note If the process fails for any reason, the Trigger Service appends the extension 
“.failed” to the trigger file name. 

12. The Trigger Service repeats this entire process each time that it detects a tar-file 
trigger file. 
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Requirements 

Environment 
• One or more computers, depending on workflow (see pages 25 and 26) 

o Dedicate all computers used to perform VOD Content Encoding solely to 
encoding:  

Important To permit the encoding software to run without interference, disable 
antivirus and firewall programs. If this is not possible, add the *.exe files 
to the “exclude” or “trust” list in your antivirus software. For details, see 
“Encoder Services Are Not Running or Repeatedly Fail” on page 49. 

o Do not install any USB drives other than the SID/TIC Drive on any computer 
used in performing encoding or encoding-related functions. 

o Do not install software that does not relate to encoding such as email, word 
processing, spreadsheets, etc. 

• Platforms—one of the following Microsoft® Windows® operating systems: 

o Windows XP 32-bit operating system 

o Windows 7 operating system 

o Windows Server 2008,32-bit  

o Windows Server 2008 64-bit 

• Preferred screen resolution of 1024 x 768 pixels, although 800 x 600 is acceptable 

• IP connectivity 

VOD Content Encoding Package 
The installation package for the VOD Content Encoder includes the following items: 

• SID/TIC Installer application 

• 1 or 2 SID/TIC Drives (USB) with label identifying software version, serial number, 
company name, and SID 

 
Figure 1 – SID/TIC Drive 

Note In configurations where having a single point of failure is unacceptable, you can 
install two SID/TIC Servers in the network. For such setups, Nielsen provides a 
SID/TIC Drive for each active SID/TIC Server. Both Drives are programmed with 
the same SIDs; however, for each SID in the list, each Server manages a unique 
set of TICs.  
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• VOD Content Encoding application 

• File Transfer Manager application 

Digital Assets 
Important All digital assets processed by the VOD Content Encoder must be clean: they 

cannot contain any Nielsen watermarks. 

Supported Formats 
• MPEG-2 transport stream files with audio stream in AC3 format conforming to CableLabs 

Content Encoding Specification MD-SP-VOD-CEPT-I01-040107. 

• MPEG-2 transport stream files with audio stream in AES3/PCM format 

• AC3 files—48 kHz 

• AES3-LPCM files format 

o 16-bit, 48 kHz 

o 20-bit, 48 kHz 

o 24-bit, 48 kHz 

Note The VOD Content Encoder does not support encoding of MPEG files with both 
AC3 and PCM in the same file. 

Audio Clusters 
Beginning with version 3.1, the VOD Content Encoder has the capability to encode media 
files that contain more than 8 audio channels and files that contain audio for different 
distribution purposes, such as for different languages of the same video. Each cluster can 
support 2, 4, 6, or 8 audio channels. Up to 8 clusters can be defined. The total number of 
audio channels in all clusters assigned must match the total number of audio channels in the 
media file. Table 5 shows examples of valid and invalid entries for audio clusters.
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Table 5 – Audio Cluster Assignment Examples 

# of Audio 
Channels <n1> <n2> <n3> <n4> <n5> <n6> <n7> <n8> Valid/Invalid 

8 2 2 2 2 0 0 0 0 
Valid (need only 
include cluster 1 
to cluster 4) 

8 8 0 0 0 0 0 0 0 
Valid (need only 
include cluster 
1) 

16 8 8 0 0 0 0 0 0 
Valid (need only 
include cluster 1 
to cluster 2) 

16 8 2 2 2 2 0 0 0 
Valid (need only 
include cluster 1 
to cluster 5) 

8 2 2 2 2 2 0 0 0 
Invalid (too many 
channels in 
clusters) 

8 2 2 0 0 0 0 0 0 
Invalid (not 
enough channels 
in clusters) 

8 2 0 2 2 2 0 0 0 
Invalid (cluster 2 
skipped) 
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Installing the Software Applications 
Important To permit the encoding software to run without interference, disable antivirus and 

firewall programs. If this is not possible, add the *.exe files to the “exclude” or 
“trust” list in your antivirus software. For details, see “Encoder Services Are Not 
Running or Repeatedly Fail” on page 49. 

As you review the procedures in this section, keep in mind that there are two results we want 
from the process: encoded files to be provided for viewing and transfer of metadata files to 
the Nielsen CF to enable crediting of viewing. 

Installing the VOD Content Encoder Application 
1. Insert the SID/TIC Drive into a USB port on a computer. 

2. Browse to the drive. 

3. Double-click autorun.exe in the VOD Encoder folder. The Nielsen VOD Content 
Encoder installation window appears. 

 
Figure 2 – Installation Window 

4. On the VOD Content Encoder installation window, click Install VOD Content Encoder. 

5. Click Next. 

6. Enter your User Name and Company Name. 

7. Click Next. 

8. If prompted, install the Microsoft Visual C++ 2010 x86 Redistributable Package. 

9. If a newer version of Visual C++ 2010 Redistributable is already installed , click Close.  

10. If prompted, install Microsoft .Net Framework 4. 

11. If Microsoft .NET framework 4 has not been detected on the machine, select I accept 
license terms and click Install to continue installation.  
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a. If a newer version Microsoft .NET framework is detected on the machine, click 
Close to continue installation.  

12. If Microsoft .NET framework 4 has been detected on the machine, click Cancel (DO 
Not Repair/Remove ) and continue installation 

13. Click Install. A message appears regarding changes to your firewall software. See 
Figure 3. 

 
Figure 3 – Firewall Message 

14. Assuming you have cleared this installation with your IT administrator, click Yes. A 
command line window appears and shows progress then closes and a message 
appears indicating the installation is complete. 

15. On the InstallShield Wizard, click Finish. 

Installing the SID/TIC Server 
Important A computer that hosts a SID/TIC server can have only one USB drive installed at 

a time and it must be a SID/TIC Drive. A network, however, can have more than 
one SID/TIC Server running on it.  

1. Insert the SID/TIC Drive into a USB port on the host computer. 

2. Browse to the drive. 

3. Double-click autorun.exe in the VOD Encoder folder. The Nielsen VOD Content 
Encoder installation window appears. See Figure 2 on page 18. 

4. Click Install SID/TIC Server. 

5. Click Next. 

6. Enter your User Name and Company Name. 

7. Click Next. 

8. Click Install. 

9. Click OK. 

10. If prompted, do one of the following: 

o If the Microsoft Visual C++ 2010 x86 Redistributable Package has not been 
detected on the machine, follow the prompts to install it. 

o If a newer version of Visual C++ 2010 Redistributable is already installed, click 
Close.  

11. If prompted, do one of the following: 



 VOD Content Encoder User Manual 

 
 20 Revision C 

o If Microsoft .NET framework 4 has not been detected on the machine, select “I 
accept license terms” and click Install.  

o If a newer version of Microsoft .NET framework is detected on the machine, click 
Close to continue the VOD Content Encoder installation. 

o If Microsoft .NET framework 4 has been detected on the machine, click Cancel 
(DO Not Repair/Remove) and continue the VOD Content Encoder installation. 

 
Figure 4 – SID/TIC Drive Installer Window 

12. On the SID/TIC Drive Installer window, click Install Drive. A message appears that the 
install is successful. 

13. Assuming you have cleared this installation with your IT administrator, click Yes. A 
command line window appears and shows progress then closes, followed by an 
indication that the installation is complete. 

14. On the InstallShield Wizard, click Finish. 

15. Click Exit. 

Installing the File Transfer Manager 
Because the File Transfer Manger is incorporated into the VOD Content Encoder application, 
the installation software stops you from installing the FTM software on the same computer as 
the encoder application. 

Important If a computer already has a third party FTP program installed, do not install the 
File Transfer Manager application on it. If, however, you want to do batch 
processing, you must disable the FTP program and install the File Transfer 
Manager. 

1. Insert the SID/TIC Drive into a USB port on the host computer. 

2. Browse to the drive. 

3. Double-click autorun.exe in the VOD Encoder folder. The Nielsen VOD Content 
Encoder installation window appears. See Figure 2. 

4. Click Install File Transfer Manager. 

5. Click Next. 

6. Enter your User Name and Company Name. 

7. Click Next. 
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8. Click Install 

9. If prompted, do one of the following: 

o If the Microsoft Visual C++ 2010 x86 Redistributable Package has not been 
detected on the machine, follow the prompts to install it. 

o If a newer version of Visual C++ 2010 Redistributable is already installed, click 
Close.  

10. If prompted, do one of the following: 

o If Microsoft .NET framework 4 has not been detected on the machine, select “I 
accept license terms” and click Install.  

o If a newer version of Microsoft .NET framework is detected on the machine, click 
Close to continue the VOD Content Encoder installation. 

o If Microsoft .NET framework 4 has been detected on the machine, click Cancel 
(DO Not Repair/Remove) and continue the VOD Content Encoder installation. 

 
Figure 5 – Firewall Message 

11. . When the install completes, a message appears regarding the firewall. Assuming 
you have cleared this installation with your IT administrator, click Yes. A command 
line window appears and shows progress then closes, followed by an indication that 
the installation is complete. 

12. On the InstallShield Wizard, click Finish.0 
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Configuring the Software Applications 
This section covers the following tasks: 

• VOD Content Encoder application 

• (Optional) File Transfer Manager application 

• (Optional) File Trigger Service 

Configuring the VOD Content Encoder Application 
Note For instructions on configuring and using the ContentCodeCmd tool instead of the GUI 

(graphical user interface), see “Encoding Using the Command Line” on page 35. 

1. Restart your antivirus software. 

2. Add the following to the list of “exclude” or “trusted” files in your antivirus software: 

o SIDTicService.exe 

o STSDiscovery.exe 

o VODFileTrigger.exe 

o VODFTMService.exe 

3. From the list of programs in Windows, select VOD Content Encoder. One of the 
following occurs: 

 
Figure 6 – VOD Content Encoder Command 

o If the application can communicate with its SID/TIC Server and there is no valid 
profile, the VOD Content Encoder application window in Figure 7 appears. 

o If the application finds a valid profile file, the Profile Editor window (Figure 8) 
appears. Go to step 9. 

o If the application cannot communicate with its SID/TIC Server, the Encoder 
Configuration (System Setup) window (Figure 9) appears. Go to the next step. 
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Figure 7 – VOD Content Encoder Window 

4. From the Configure menu, select Profile Setup. See Figure 8. 

5. On the Profile Editor window, enter a Profile Name. 

Note Once you assign a Profile Name, you cannot change it. To rename a profile, you 
would have to delete the profile and add a new one. 

 
Figure 8 – Profile Editor Window 

6. Browse to the location of each item in Table 6. 

Table 6 – Profile Window 

Field Path 

Video Source Path Files to be encoded 

Encoded File Path Saved encoded files 

ADI File Path (If applicable) ADI-compliant files to be 
transferred 

 
7. Select a SID / Distrib Source. 

8. Click Apply. 
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9. From the Configure menu, select System Setup. The Encoder Configuration window 
appears. See Figure 9. 

Refer to Table 7 for the settings and to Figure 10, Figure 11, Figure 12, Figure 13, 
and Figure 14 for the corresponding workflows. 

 

Figure 9 – Encoder Configuration (System Setup) Window 

Table 7 – Summary of Configuration Settings for Figure 9 

Workflow 
SID/TIC Server 

Parameters  
Feed-Point Transfer 

Parameters 

Figure 10 

Computer 1: SID/TIC 
Server and Encoder 

Defaults Defaults 

Figure 11 

Computer 1: SID/TIC 
Server 
Computer 2: Encoder 

Computers 1 and 2: IP 
address of SID/TIC 
Server, Discovery Server 
Port default 

Defaults 

Figure 12 

Computer 1: SID/TIC 
Server and Encoder 
Computer 2: File Transfer 
Manager (FTM) 

Computer 1: IP address 
of SID/TIC Server, 
Discovery Server Port 
default 
Computer 2: defaults 

Computer 1: 
communications 
parameters for Computer 2 
Computer 2: defaults 

Figure 13 

Computers 1 and 2: 
Redundant SID/TIC Servers 
Computer 3: Encoder and 
FTM 

Computers 1, 2, and 3: 
255.255.255.255, 
Discovery Server port 
default 

Computers 1 and 2: 
defaults 
Computer 3: defaults 

Figure 14 

Computer 1: SID/TIC 
Server 
Computer 2: Encoder 
Computer 3: FTM 

Computers 1 and 2: 
255.255.255.255, 
Discovery Server port 
default 
Computer 3: defaults 

Computer 1: defaults 
Computer 2: 
communications 
parameters for Computer 3 
Computer 3: defaults 
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Figure 10 – Workflow 1 

 
Figure 11 – Workflow 2 

 
Figure 12 – Workflow 3 
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Figure 13 – Workflow 4 

 
Figure 14 – Workflow 5 
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(Optional) Configuring the File Transfer Manager Application 
Note Configuring the File Transfer Manager application is necessary if you install the VOD 

Content Encoder application on a separate machine.  

1. From the list of programs in Windows, select File Transfer Manager. 

2. Select the Transfer Mode and do one of the following: 

• If you select Transfer to Data Collection Facility (direct transfer to CF), the 
contents of File Transfer Configuration window is automatically filled with 
data in the configuration file provided by Nielsen. Go to step 3 and update 
Metadata Folder and Archive Folder to match them with your environment. 

• If you select Transfer to Local Server (indirect transfer to CF), go to step 3.  

 
Figure 15 – Transfer Configuration Window
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3. Complete the fields shown in Table 8. 

Table 8 – Feed-Point Transfer Parameters for Figure 15 

Field Description 

Metadata Folder The local location of the metadata files to be transferred 

Default is C:\Program Files\Nielsen\metadata. 

Archive Folder The local location of the folder where metadata files that 
already transferred are stored 

Default is C:\Program Files\Nielsen\arch_metadata 

Server Address Supplied by Nielsen 

Server Port 8080 

Proxy Server Supplied by Nielsen 

Proxy Port 6380 

Local Port 8080 

Server Login Supplied by Nielsen 

Server Password Supplied by Nielsen 

Remote Folder The folder on your transfer server where the metadata 
files are stored before transfer to the CF 

 
4. Click Save and close the window. Files are sent on the set interval. 

(Optional) Configuring the File Trigger Service 
The VOD File Trigger Manager application is automatically installed during the VOD Content 
Encoder application installation. This is an optional service that you can use to manually or 
automatically trigger file transfers. 

The File Trigger Service monitors a “watch” folder that contains an XML trigger file that 
initiates encoding with the content identified in the file. The File Trigger Service (the Trigger 
Service) uses SSH to send the files to the CF. The configuration application creates a 
configuration file that it places in the “etc” directory where the Encoder is installed. 

 For more details on the File Trigger Service, see “Transferring Metadata to the Nielsen 
Collection Facility” on page 8. 
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Configuring the Trigger Service to Run Manually 
1. From the Windows Start menu, select Nielsen > VOD File Trigger Manager. 

2. On the File Trigger Manager window, browse to the XML File Path to the trigger file 
watch folder. See Figure 16. 

Note The Appendix shows examples of the XML files. 

3. Browse to the Scratch folder.  

4. Click Save Config. 

Note If the Monitor File Trigger Service checkbox is checked in the 
VODServicesMonitorTool dialog box, the VOD File Trigger Manager service 
automatically restarts. 

 
Figure 16 – File Trigger Manager Window 

Configuring the File Trigger Service to Run Automatically 
1. To start automatically after reboot, open the Control Panel. 

2. Select Administrative Tools > Services. 

 
Figure 17 – Administrative Tools > Services 

3. Right-click NIELSEN VOD File Trigger Service and select Properties from the menu. 
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Figure 18 – File Trigger Service in Services 

4. In Startup type on the Properties window, select Automatic. 

 
Figure 19 – File Trigger Service Properties 

5. Click OK. 
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Encoding and Decoding 

Encoding Using the GUI 
Important All digital assets processed by the VOD Content Encoder must be clean: they 

cannot contain any Nielsen watermarks. 

1. From the Start menu, start the VOD Content Encoder application. 

2. On the Configure menu, select Profile Setup. 

3. Select the profile you want and click Apply. 

 
Figure 20 – Profile Editor 

4. On the Source Video tab, select an MPEG-2 file to be encoded.  

 
Figure 21 – Main Window 

5. Click Encode. The Feed Point Information window appears (Figure 22). One of the 
following occurs:  

o The selected file contains multiple audio channels. The Feed-Point Information 
window displays Total Channels with the number of channels found in the media 
file and Clusters fields ready for you to assign cluster IDs (circled in red in Figure 
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22), applicable to content with AES3 audio only. For more information, see 
“Audio Clusters” on page 9. Go to step 6. 

o The window does not display Cluster-related fields (content with AC3 audio). Go 
to the next step 7. 

6. Enter an ID for each channel cluster. 

 
Figure 22 – Feed-Point Information Window 

7. (Optional) If available, browse to select the corresponding ADI file. The file must be 
compliant with the CableLabs specification/ 

8. Enter the following: 

o Asset ID—uniquely identifies the asset that is being encoded. If a CableLabs® 
ADI file is identified for the asset, then this field is populated with the Asset ID 
from the ADI file. 

o Asset Name—descriptive name of the asset being encoded.  

o Episode ID—(optional) uniquely identifies the episode of the asset. 

Note The Dist Src ID and Name, Nielsen SID, and Duration are populated from the 
Encoder configuration and are read-only. 

9. Click OK. If the encoding session completes successfully a “Watermarking 
succeeded” message appears. “Finished processing Status” shows a return code of 
0. See Figure 23. 



 VOD Content Encoder User Manual 

 
 33 Revision C 

 
Figure 23 – Watermarking Successful Message 

10. Click OK. 

11. Click Close. The main window also indicates the success of the encoding process.  

 
Figure 24 – Watermarking Success Indicators 
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Decoding Using the GUI 
To verify that encoding occurred, and that TICs were inserted, decode the encoded file. 

1. Start the VOD Content Encoder application. 

2. On the Encoded Video tab, select the file to decode. 

 
Figure 25 – Decoding 

3. Click Decode. The Decoding status dialog box appears and fills with the SID/TIC 
information. When the decoding process is complete, the dialog box displays a 
summary of the watermarks that were detected for each SID. 

 
Figure 26 – Decoder Output 
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Encoding Using the Command Line 
The command-line version of the VOD Content Encoder is called ContentCodeCmd. 
ContentCodeCmd enables you to automate encoding and decoding. 

Note You can also automate file transfer. For more information, see “Transferring Metadata to 
the Nielsen Collection Facility” on page 8. 

ContentCodeCmd Arguments 
The VOD Encoder package includes a batch file, InsertContentCodes.bat, which includes a 
call to ContentCodeCmd.exe. You may edit the command line arguments in this .bat file to 
meet your requirements, and then execute the .bat file to conduct a single watermarking 
session. 

Table 9 – Encoding Command Line Arguments 

Argument Description 

sid Nielsen source identifier 

input Full path name of the file containing the MPEG-2 transport stream to 
be watermarked 

output Full path name of the generated watermarked file 

assetid String for content to be encoded,  

asset name Descriptive name for content to be encoded; passed to the CF in the 
feed-point metadata file 

episode String for the episode to be encoded 

adifile Full path name for CableLabs-compliant file to be transferred to the 
CF 

discovermask Broadcast subnet address that defines the set of computers that the 
application searches in the process of “discovering” an active 
SID/TIC Server. The default value is 255.255.255.255. Depending 
upon your network configuration, you may wish to further restrict the 
broadcast address to a specific subnet. For example, if your subnet 
is 10.6.1.nnn, the UDP broadcast could be modified using the 
parameter –discovermask 10.6.1.255. 

discoverport Number of the User Datagram Protocol port on which the Discovery 
Server listens for UDP broadcasts. The default value is 6543. Only 
modify this port if it conflicts with some other service on your 
network. 

server Fixed network address of the host where the SID/TIC service is 
running. If your site uses dynamic address assignment (DHCP), you 
must use the discovery feature (do not set the server IP address). 



 VOD Content Encoder User Manual 

 
 36 Revision C 

Argument Description 

-cl n (For AES audio only) Values for n can be 2, 4, 6, or 8 

 Repeatable up to 8 times, for example, for a media file with 8 
channels, you could enter-cl 6 -cl 2 or -cl 4 -cl 4 or -cl 2 -cl 2 -cl 
2 -cl 2 

Note Do not enter a value of zero (0). 

Encoding Command Line Format 
When using ContentCodeCmd to encode, use this format to set the parameters described 
above: 

ContentCodeCmd   

-sid <SID>  

--input <input file>  

-output <output file> 

-assetid <asset ID> 

-asset name <asset name> 

[-episode <episode ID>] 

[-adifile <ADI file name>] 

[-discovermask <UDP broadcast address>] 

[-discoverport <UDP port number>] 

[-server <IP address>] 

[-cl <n1>] 

[-cl <n2>] 

... 

[-cl <n8> 

Encoding Example 1 
This example shows how to encode “C:\MPEGFILES\Unprocessed\test.mpg” with a 
Nielsen SID of 9001 and store the encoded file in “C:\MPEGFILES\Processed\test.mpg.” 
The sole SID/TIC service on the network is located on a host computer with the IP 
address of 10.45.212.100. 

ContentCodeCmd -sid 9001 -input "C:\MPEGFILES\Unprocessed\test.mpg"-

output C:\MPEGFILES\Processed\test.mpg --assetid "54321" -assetname 

"InterestingClip" –episode “Episode 1” –server “10.45.212.100” 

Note Because the server is automatically discovered, the –server argument is 
optional. 
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Encoding Example 2 
This example shows how to encode the same file, with the same output file name, where 
there are two active SID/TIC Servers on the system. 

ContentCodeCmd -sid 9001 -input "C:\MPEGFILES\Unprocessed\test.mpg"-

output C:\MPEGFILES\Processed\test.mpg -server "127.0.0.1" -assetid 

"54321" -assetname "InterestingClip" –discovermask “255.255.255.255” 

Decoding Using the Command Line 
You can also use ContentCodeCmd to decode Nielsen-encoded files, display the results on 
the screen, or send them to a file. ContentCodeCmd reports the results in this format. 

<stream offset>, <SID>, <code type>, <audio PID>, <TIC/timestamp> 

The VOD Encoder package includes a batch file, DisplayCodes.bat, which contains a call to 
ContentCodeCmd.exe. You may adjust the command-line arguments in this .bat file to meet 
your requirements and then execute the .bat file to conduct a single decoding session. 

Table 10 – Decoding Parameters 

Parameter Description 

Stream offset Offset from the beginning of the stream where the end of the Nielsen 
watermark is located. The <stream offset> is expressed as  
hours : minutes : seconds 

SID Nielsen source identifier 

Code type PC” for program content or “FD” for final distributor. The VOD Content 
Encoder inserts “PC” watermarks. If the decoder reports “FD” watermarks, 
those watermarks were inserted by other Nielsen encoder 

Audio PID MPEG PID that identifies the AC-3 or AES PCM stream in which the Nielsen 
watermark was found 

TIC/Timestamp Numeric value that identifies a specific segment of the encoded asset. Each 
four-second segment of code has its own unique TIC or timestamp 

 

Table 11 – Decoding Command Line Arguments 

Argument Description 

-decode Activity the tool should do 

-input Full path name of the file to be decoded 

The following is an example of decoding a file, “C:\MPEGFILES\Processed\test.mpg,” and 
storing the report in a file, “C:\Temp\decoder_out.txt,” while displaying the report on the 
screen:  

ContentCodeCmd –decode –input “C:\MPEGFILES\Processed\test.mpg”  
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Transferring Metadata Files to the Nielsen CF 
For crediting, your plant must transfer metadata files to the Nielsen CF. There are several 
possible ways to transfer the files: through the content encoder itself, using the File Transfer 
Manager application, or using the File Trigger Service to manually or automatically transfer 
the files. 

Transferring Files Using the VOD Content Encoder GUI 
On the File menu in the VOD Content Encoder application, select Transfer. All files in the 
Nielsen\metadata directory transfer to the CF or the Local Service, depending on your 
configuration. 

Transferring Files Using the File Transfer Manager 
On the File menu in the File Transfer Manager application, select Transfer. All files in the 
Nielsen\metadata directory transfer to the CF. 

Transferring Files Using the File Trigger Service 

Manually Triggering File Transfer 
1. From the Windows Start menu, select Nielsen > VOD File Trigger Manager. 

 
Figure 27 – VOD File Trigger Manager 

2. Click Start Service. The Trigger Service runs until you stop it or reboot the system. 

 
Figure 28 – File Trigger Manager Window 
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Note If the Trigger Service fails while processing a trigger file, it renames the trigger 
file (appending the ".failed" extension) instead of deleting the file. The Trigger 
Service does not attempt to process the renamed trigger file until the extension in 
the file name is changed to xml. 

Note If the Monitor File Trigger Service checkbox is checked in the VOD 
ServicesMonitorTool dialog box, the VOD File Trigger Service automatically 
restarts. 

3. To stop the Trigger Service, click Stop Service. 

4. Close the window. 

Automatically Triggering File Transfer 
See “Configuring the File Trigger Service to Run Automatically” on page 29. 

Note If the XML file contains a tar file path, the Trigger Service automatically processes the files 
according to “Using the File Trigger Service with Tar Files” on page 12. 
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Maintaining the Encoder 
This section covers procedures that you may periodically do. 

Restarting the SID/TIC Server 
For instructions on restarting the SID/TIC Server, see “Verify the SID/TIC Server Is Running” 
on page 56. 

Adding a New Distribution Source or SID 
If you begin encoding content for a new distributor, you must first add a new distribution 
source and then add a new SID. 

Important Facilities that use two active SID/TIC Servers, must add the same SIDs and 
Distribution Sources to each SID/TIC Drive. Maintaining the same list of SIDs 
and Distribution Source information is extremely important. 

Adding a New Distribution Source 
1. Ensure that the Encoder has access to the SID/TIC Server. 

2. Start the SID/TIC Drive Installer application. 

 
Figure 29 – SID TIC Drive Installer 

3. Contact the Nielsen Encoder Support group at 800-537-4872 option 2 or send an 
email to Encoders@nielsen.com.  

mailto:Encoders@nielsen.com
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4. On the SID/TIC Drive Installer window, click Add DSID (#1 in Figure 30). 

 
Figure 30 – SID/TIC Drive Installer 

5. On the Distribution Source List Editor window (Figure 31), enter the new Distribution 
Source ID (#1 in Figure 31). 

 
Figure 31 – Distribution Source List Editor 

6. Enter the new Distribution Source Name (#2 in Figure 31). 

7. Enter the Passcode (#3 in Figure 31) supplied by Encoder Support. 

8. Click Write to Drive (#4 in Figure 31). The window closes. 

9. On the SID/TIC Drive Installer window, click Install Drive (#2 in Figure 30). A message 
appears that the install is successful. 

10. Click OK. The window closes. 
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Adding a New SID 
If you are encoding for a new distributor, first add a new DSID before performing this 
procedure. 

1. Make a note of the serial number for your SID/TIC Drive. 

2. To get a new SID, contact Nielsen Encoder Support at 800-537-4872 option 2 or 
send an email to Encoders@nielsen.com. 

3. Do one of the following: 

o If you are encoding for a new distributor, add a new DSID and then go to step 4. 
See “Adding a New Distribution Source” on page 40. 

o If you are not adding a new DSID, go to step 4. 

4. Ensure that you have access to the SID/TIC Server host consumer. 

5. Ensure that you can activate the SID/TIC Drive Installer application. 

6. On the SID/TIC Drive Installer window, click Add SID (#1 in Figure 32).  

 
Figure 32 – SID/TIC Drive Installer 

7. On the SID/TIC Drive Editor window, enter the SID (#1 in Figure 33) that Encoder 
Support provided. 

8. Do one of the following: 

o If the Dist Src ID list contains the correct DSID (#2 in Figure 33), select it and go to 
step 9. 

o If the Dist Src ID list does not contain the DSID, click Distribution Source List 
Editor (#3 in Figure 33). See “Adding a New Distribution Source” on page 40. 

mailto:Encoders@nielsen.com


 VOD Content Encoder User Manual 

 
 43 Revision C 

 
Figure 33 – SID/TIC Drive Editor Window 

9. Enter the Password (#4 in Figure 33) that Encoder Support provided. 

10. Click Write to Drive (#5 in Figure 33). The window closes. 

11. On the SID/TIC Drive Installer window, click Install Drive (#2 in Figure 32). A message 
appears that the installation is successful. 

12. Click OK. The window closes. 
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Adding a New Profile 
A profile contains the locations you specify for the video source files, encoded files, and ADI 
files plus the SID and DSID. 

1. On the VOD Content Encoder application window, from the Configure menu, select 
Profile Setup. 

2. On the Profile Editor window, click Add. 

 
Figure 34 – Profile Editor Window 

3. Enter a Profile Name. 

Note Once you assign a Profile Name, you cannot change it. To rename a profile, you 
would have to delete the profile and add a new one. 

4. In Video Source Path, browse to the location for the video source(s). 

5. In Encoded File Path, browse to the location for the encoded file(s). 

6. (Optional) In ADI File Path, browse to the location for the ADI file(s). 

7. Select a SID / Distrib Source. 

8. Click Apply. The window closes. 
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Editing a Profile 
You can only edit the paths and distribution source. To rename a profile, you must create a 
new profile. 

1. On the VOD Content Encoder application window, from the Configure menu, select 
Profile Setup. 

2. On the Profile Editor window, click Edit. 

Note You cannot change the name of an existing profile. Instead you would have to 
delete the existing one and create a new one. 

 
Figure 35 – Profile Editor Window 

3. In Video Source Path, browse to the location for the video source(s). 

4. In Encoded File Path, browse to the location for the encoded file(s). 

5. (Optional) In ADI File Path, browse to the location for the ADI file(s). 

6. Select a SID / Distrib Source. 

7. Click Apply. The window closes. 
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Deleting a Profile 
1. On the VOD Content Encoder application window, from the Configure menu, select 

Profile Setup. 

2. In the Profile List (#1 in Figure 36), select the profile. 

 
Figure 36 – Profile Editor Window 

3. Click Delete (#2 in Figure 36). A warning message appears. 

 
Figure 37 – Deleting Profile Warning Message 

4. Click OK. 

Important If you decide not to delete the profile, click Cancel rather than Apply on the 
Profile Editor window. 

5. Click Apply. The Profile Setup window closes. 
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Configuring the ServicesMonitorTool 
The ServicesMonitorTool is an application that, by default, monitors all services. If a 
metadata file transfer to the CF fails, the tool displays a notification message and restarts 
stopped services. 

The ServicesMonitorTool is automatically installed with the VOD Content Encoder software, 
File Transfer Manager Software, and SID/TIC server. During installation, the 
ServicesMonitorTool is configured to monitor these services: 

• File Transfer Service 

• File Trigger Service 

• Discovery Service 

• SID/TIC Server Service 

1. To open the ServicesMonitorTool, do one of the following: 

o In the System Tray, click the VOD ServicesMonitorTool icon. 

o Browse to the Program Files > Nielsen folder and double-click 
ServicesMonitorTool.exe. 

 
Figure 38 - ServicesMonitorTool 

2. (Optional) To disable notifications of file transfer failures, on the GUI, clear the 
TurnOffErrorPopup check box (#1 in Figure 38). 

Important Turning off the notification is not recommended. 

3. To edit the services that the tool monitors (#2 in Figure 38)., do the following: 

o To stop monitoring a currently monitored service, clear the check box. 

o To resume monitoring a service, check the check box. 

4. To view the VOD debug and transfer logs, do the following: 

a. Click View Log (#3 in Figure 38). 
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b. Browse to the file and select it. Open the file in Windows Notepad. 

5. To save the configuration to a file, click Save. 

Note If you clicked Cancel or Close or minimized the dialog box, the settings revert to 
the previous configuration.  
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Troubleshooting 

Encoder Services Are Not Running or Repeatedly Fail 
Important VOD Content Encoder applications should only be installed on systems used 

solely for Nielsen encoding 
To permit the encoding software to run without interference, antivirus and firewall 
programs should be disabled. If disabling is not possible, the security software 
must be configured to permit the files listed in the procedure below to run. 

Certain Internet security virus-protection applications may interfere with the VOD Content 
Encoder services and produce any or all of the following issues: 

• SID/TIC Discovery Server is not running or its function repeatedly fails. 

• SID/TIC Server Service is not running or its function repeatedly fails. 

• File Transfer Service is not running or its function does not automatically occur. 

• After successful installation of the VOD Content Encoder application, the 
VODFTMService.exe and/or VODFileTrigger.exe files disappear from the installation 
folder. 

• After successful installation of the SID/TIC Server application, the STSDiscovery.exe, 
and/or SIDTicService.exe files disappear from the installation folder. 

When these issues could be related to antivirus software (see the rest of the 
“Troubleshooting” for other, potential causes), do the following: 

1. To see whether your antivirus software may be interfering with the encoding 
software, do the following: 

a. Open the history feature in the antivirus program. 

b. Examine the events for evidence of the encoder services stopping or failing. 

2. Add the following files to the “exclude” or “trust” feature in your antivirus program. 

On a computer installed 
with... 

Trust or exclude this file in 
antivirus software: 

SID/TIC Server SIDTicService.exe and 
STSDiscovery.exe 

VOD Content Encoder VODFileTrigger.exe 

VODFTMService.exe 

File Transfer Manager VODFTMService.exe 
 

3. Reboot your system. 

4. In Windows Control Panel (or equivalent), select Administrative Tools. 

5. Select Services and ensure that all of the following that apply to your system are 
operating correctly: 

o NIELSEN DISCOVERY SERVICE Status is Started. 
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o NIELSEN FILE TRANSFER MANAGER SERVICE Status is Started. 

o NIELSEN SID TIC SERVER Status is Started. 

o NIELSEN VOD File Trigger Service Startup Type is Manual. 

 
Figure 39 – Windows Services 

6. If any services are missing, do the following: 

o In Windows XP OS, from All Programs, select Nielsen > RestoreNielsenServices. 

o In Windows 7 or Windows Server, do the following: 

a. Select All Programs > Nielsen and right-click RestoreNielsenServices. 

b. Select Run As Administrator. 

7. Ensure that the ServicesMonitorTool is running and the corresponding services check 
box is checked. 

 
Figure 40 – ServicesMonitorTool 

Files or Codes Are Missing  
Use these steps to uncover root causes when encoding is not successful. 
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MPEG Files Missing on Source Video Tab 
It may be that the incorrect profile for this encoding session was selected or you may need to 
create a new profile with the correct video source path. 

1. From the Start menu, start the VOD Content Encoder application. 

2. On the Configure menu, select Profile Setup. 

 
Figure 41 – Video Source Path in Profile Editor 

3. Do one of the following: 

o Ensure that the Video Source Path specifies the location of the file that you would 
like to encode. See “Editing a Profile” on page 45. 

o Create a new profile. See “Adding a New Profile” on page 44. 

Missing Files on the Encoded Video Tab 
An incorrect profile for this decoding session may have been selected. 

1. From the Start menu, start the VOD Content Encoder application. 

2. On the Configure menu, select Profile Setup. See “Editing a Profile” on page 45. 

 
Figure 42 – Encoded File Path in Profile Editor 
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3. Ensure that the Encoded-File Path specifies the full path name of the file that you just 
encoded.  

Unable to Create or Write to the Output File 
Ensure that the encoded path that you selected is not read-only (Figure 42).  

Missing or Few Watermarks When File is Decoded 
If the content was difficult to encode (very quiet, for example) or if the AC-3 stream bit rate 
was too low, the Encoder may not have been able to insert as many audio codes as 
expected.  

Ensure that audio levels are properly set at the broadcast facility. See the Encoding 
Installation and Configuration Policy.  

Nielsen Unable to Detect Watermarks in Encoded File  

Ensure that audio levels are properly set at the broadcast facility. See the Encoding 
Installation and Configuration Policy.  

Ensure that you pitched the encoded file, not the original source file. 

Encoding Takes Too Long 
Ensure that other processes are not tying up the encoding system. Transferring large files to 
or from the Encoder host computer, for example, is very likely to slow the encoding process. 

http://nielsen-encoder-forum.com/public/documentation/Encoding_Install_Config_Policy.pdf
http://nielsen-encoder-forum.com/public/documentation/Encoding_Install_Config_Policy.pdf
http://nielsen-encoder-forum.com/public/documentation/Encoding_Install_Config_Policy.pdf
http://nielsen-encoder-forum.com/public/documentation/Encoding_Install_Config_Policy.pdf
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SID/TIC Request Failed or Unable to establish valid connection 
with SID/TIC Server  

To start an encoding session, the Encoder must first establish a network connection to a 
properly configured, active SID/TIC Server. Even if the Server resides on the same computer 
as the Encoder, the Server and the Encoder application communicate using TCP/IP protocol. 
Communication issues may occur that prevent encoding from taking place.  

If you see an error message, “SID/TIC Request Failed” or “Unable to establish valid 
connection with SID/TIC Server,” use the following steps to look for root causes. 

1. Communications with Nielsen Fail 

Check your firewall to ensure it is not preventing communications between the Server 
and the Encoder. 

2. Communications with SID/TIC Server Fail 

a. To check whether the SID/TIC Server address is correct, on the VOD Content 
Encoder application window, select Configure > System Setup. See Table 7 – 
Summary of Configuration Settings for Figure 9 on page 24. 

 
Figure 43 – VOD Content Encoder Window 

 

b. If the address is valid, note the following to determine whether it is a subnet mask 
or a specific IP address: 

• Subnet mask—if the address is set to 255. 255. 255. 255, the address is a 
mask, go to “Verify the Discovery Server Is Running.” 

• Specific IP address—if the address does not contain any 255 segments 
(Figure 44), the address is a specific IP address, which means the Encoder 
uses the “direct connection” method of connecting to the SID/TIC Server.  
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Figure 44 - SID/TIC Server Address or Mask 

3. Test the Connection to the SID/TIC Server 

a. Open a command line window. 

b. Type ipconfig and press Enter. 

c. Note the IP Address. This address is the IP address of the SID/TIC Server host 
computer. 

d. Do one of the following: 

• If the address returned matches the address in the Encoder Configuration 
window (Figure 44), go to “Run a SID/TIC Server Test.” 

• If the address returned does not match the address in the Encoder 
Configuration window, do the following: 

a. Start the VOD Content Encoder application. 

b. Select Configure > System Setup. 

c. Enter the correct address or mask into SID/TIC Server IP Address or Mask 
in the Encoder Configuration window. 

4. Run a SID/TIC Server Test 

On the Configure menu in the VOD Content Encoder window, select SID/TIC Server 
Test. One of the following occurs: 
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Figure 45 – VOD Content Encoder Window 

• A message appears, “Discovered an active SID/TIC Server at IP address 
xxx.xxx.xxx.xxx.”   

• The Encoder is properly communicating with the SID/TIC Server. 

• A message appears, “Invalid response from SID/TIC Server at IP Address 
xxx.xxx.xxx.xxx.” 

• It is likely that the IP address identifies a computer that has a SID/TIC Server 
on it, but that the SID/TIC Server is improperly configured. Recheck the 
SID/TIC Server setup at the specified address. 

• A message appears, “Unable to discover an active SID/TIC Server at 
xxx.xxx.xxx.xxx.”  

• A properly configured SID/TIC Server is not running at the specified address. 
Recheck the IP address and the configuration of the software and SID/TIC 
Drive at that IP address. 

5. Verify the Server Software Is Installed 

a. Start the SID/TIC Drive Installer application.  

 
Figure 46 – SID/TIC Drive Installer 

One of the following occurs: 

•  The command appears in the menu. Go to “Verify the SID/TIC Server Is 
Running” below. 

• The SID/TIC Drive Installer application does not appear in the list of 
programs. This indicates the SID/TIC Server software was not properly or 
fully installed. Go the next step. 
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b. To install the SID/TIC Server application, see “Installing the SID/TIC Server” on 
page 19. 

Note The SID/TIC Server may reside on the same computer as the Encoder, or it may 
be on a different computer on the same subnet. 

6. Verify the SID/TIC Server Is Running 

a. In Windows Control Panel (or equivalent), select Administrative Tools. 

b. Select Services.  

c. Check that the Status of the Server is Started and the Startup Type is Automatic. 
See #1 in Figure 47. 

 
Figure 47 – Services Window 

•  If the settings are correct, go to “Verify the Discovery Server Is Running” on 
page 57. 

• If the settings are not correct, do the following: 

a. Right-click the service name and select Properties. 

b. To set the Server to automatically start, in Startup type on the General tab 
(#1 in Figure 48), select Automatic. 

c. In the Service status section, click Start. 

d. Click OK. 
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Figure 48 – SID/TIC Server Properties Window 

7. Verify the Discovery Server Is Running 

Use the procedure above for verifying the SID/TIC Server is running, except check 
that the Discovery Service is running. See #2 in Figure 47 – Services Window. 

Note This step only applies if you rely on the discovery method of identifying a SID/TIC 
Server. The Discovery Server should be running ONLY if you supply a subnet 
mask instead of a SID/TIC Server IP address on the Encoder Configuration 
window of the Encoder application. 

8. Verify Installation of the SID/TIC Drive 

Check that a Nielsen-programmed SID/TIC Drive is in a USB port on the SID/TIC 
Server host computer. Do one of the following: 

o  If the Drive is inserted and the SID/TIC Installer is installed, go to the next 
section, “Check the Contents of the SID/TIC Drive.” 

o If the SID/TIC Drive is not inserted, follow the procedure in “Installing the SID/TIC 
Server” on page 19 to install the SID/TIC Drive databases on the host computer. 

9. Check the Contents of the SID/TIC Drive 

a. From the Start menu (or equivalent), open the SID/TIC Drive Installer application. 
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Figure 49 – SID/TIC Drive Installer Window 

b. In the section, SIDs Currently on Drive, verify that the following information is 
correct. 

• Do the expected SIDs and distribution source appear in the list? 

• If not, do most of the SIDs in the list appear to be valid? If any SIDs are 
missing, see “Adding a New Distribution Source” on page 40.  

• If the entries appear, are they garbled or are some missing? If so, you may 
need to restore the SID/TIC Drive using the databases on the host computer. 
Contact Nielsen Encoder Support at 800-537-4872 option 2. 

10. Deactivate the Discovery Service 

Important Perform this step only if you do not want the SID/TIC Server on this computer 
to be “discovered” by VOD Content Encoders. 

a. In Control Panel (or equivalent), open Administrative Tools > Services. See #2 in 
Figure 47. 

b. Right-click Nielsen Discovery Service and select Properties. See Figure 50. 

c. Change the Startup type to Disabled. 
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Figure 50 – Discovery Service Properties 

d. To disable monitoring of the Discovery Service, on the task bar, click the icon for 
the ServicesMonitorTool. 

e. Clear the check box for the Discovery Service (Figure 51).  

 
Figure 51 – Do Not Monitor Discovery Service 
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Troubleshooting Issues with Transferring Metadata 
The VOD Content Encoder File Transfer Service periodically transfers any available feed-
point metadata files to the Nielsen CF. Follow these steps when metadata has not properly 
transferred. 

Verifying the File Transfer Service Is Correctly Operating 
1. In the VOD Content Encoder application, select View > Log File. 

2. Scroll through the log file and search for any of the following messages: 

o This message indicates that a file was successfully transferred to the CF at the 
time that the message was sent. 

Successfully transferred file xxx_yyy_adi.xml (where xxx is the 

SID and yyy is the first TIC). 

o This message indicates that no files have been transferred since the last 
message from the File Transfer Manager. In the absence of other, more specific 
error messages, however, this is not an error report. Instead, it merely indicates 
that there were no feed-point metadata files ready to be transferred.  

FTM: Transferred 0 files.  

o An error message in the error log or no reports from the File Transfer Manager 
over a long period indicates File Transfer Service may not be properly 
functioning.  See “Verifying the File Transfer Manager Service Is Running” on 
page 60. 

Verifying the File Transfer Manager Service Is Running 
1. To ensure that the File Transfer Manager Service is running, in the Control Panel, open 

Administrative Tools > Services. 

 
Figure 52 – Services Window 

2. In the Services list, locate Nielsen File Transfer Manager Service and do one of the 
following: 
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o If File Transfer Manager Service does not appear in the list, the Encoder software 
was not properly installed. Uninstall and reinstall the VOD Content Encoder 
software as follows: 

• If the standalone File Transfer Manager (FTM) software is installed, uninstall 
and reinstall FTM. 

• If the VOD Content Encoder (with FTM) is installed, uninstall the Encoder 
and then reinstall it. 

o If the File Transfer Manager Service DOES appear in the list (#2 in Figure 52), 
check the Status of the Trigger Service and do one of the following: 

• If the Status is not Started, right-click the File Transfer Manager Service list 
entry and select Start. 

• If the Status of the File Transfer Manager Service is Started, go to the next 
step. 

3. From the View menu on the VOD Content Encoder window, select Configure > System 
Setup. 

4. In the VOD File – Transfer Configuration window (Figure 15), verify the values are 
correct. See also Table 8 – Feed-Point Transfer Parameters for Figure 15 on page 
28. 

5. Click Save. 

6. On the File menu in the VOD Content Encoder window, select Transfer. If all 
components are properly configured, all files should transfer from the metadata folder 
to the CF and the original files to the arch_metadata folder. A message should 
confirm that the transfer was successful. If the transfer fails, do the following: 

o Check the network configuration and firewall settings on the Encoder. 

o Verify that a third-party FTP application is NOT running on the same subnet as 
the File Transfer Service by doing the following: 

a. In Control Panel (or equivalent), open Administrative Tools > Services. 
See Figure 52. 

b. Examine the Services list to see if an FTP application other than the 
Nielsen File Transfer Manager Service is running. 

c. If an FTP application is running, to prevent the application from auto-
starting during boot up, do the following: 

a. Right-click the name of the application and select Properties. 

b. Change the Startup Type to Disabled. 

Important If File Transfer Manager Service problems persist, call Nielsen Encoder 
Support to check the status of the metadata server at the Collection Facility. 
See “Customer Support” on page 5. 
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Transfer Failed: Plink Executable not Installed Error  
1. To verify whether the Plink toolset is installed, look for plink.exe in the Program files > 

Nielsen > VOD Installation folder. 

2. Do one of the following: 

o If Plink is not installed, do one of the following: 

• If the standalone File Transfer Manager (FTM) software is installed, uninstall 
and reinstall FTM. 

• If the VOD Content Encoder (with FTM) is installed, uninstall the Encoder 
and then reinstall it. 

• Copy plink.exe from the installation software to the Program files > Nielsen > 
VOD Installation folder. 

o If Plink is installed, double-click plink.exe. 

3. When the next transfer interval (approximately 15 minutes) has passed, verify that 
metadata transferred and the error does not recur. If the error recurs, contact Nielsen 
Encoder Support. 

SidTic Client Failed to Open Error 
1. Open Control Panel > User Accounts > Change User Account Control Settings  

2. Ensure the User Access Control Setting is set to low or Never Notify (Figure 53). 

 
Figure 53 – User Account Control Settings 
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Troubleshooting General Issues  

Unable to Update the Configuration on VODServicesMonitorTool  
1. Open Control Panel > User Accounts > Change User Account Control Settings  

2. Ensure the User Access Control Setting is set to low or Never Notify (Figure 53). 

VODServicesMonitorTool Reports a File Transfer Issue on the SID/TIC server  
1. Browse to the Program Files => Nielsen => log folder. 

2. In the log folder, delete the xfer_report.txt file. 

3. Check that the VOD Content Encoder application and File Transfer Manger software 
are not installed on SID/TIC server. 

4. If the applications are installed, see the section, “Troubleshooting Issues with 
Transferring Metadata” on page 60 for more options.  
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Appendix 

Contents of an XML Trigger File 
The following is an example of a Sample-File-Trigger.xml file that includes clusters. 

<ContentEncodingParams> 

 <InputFile>   

  C:\temp\VoD\Source\Sample.mpg   

 </InputFile> 

 <OutputFile>  

  C:\temp\VoD\Encoded\Sample-enc.mpg  

 </OutputFile> 

 <SID> 

  9000  

 </SID> 

 <AssetId> 

  Test ID 1 

 </AssetId> 

 <AssetName> 

  This is for File Trigger Encode Test. 

 </AssetName> 

 <Cluster1> 
  <n1> 
 </Cluster1> 
 <Cluster2> 
  <n2> 
 </Cluster2> 
... 
 <Cluster8> 
  <n8> 
 </Cluster8> 
</ContentEncodingParams> 

Example: 

For a total of 16 channels with cluster channels 8, 2, 2, 2, 2, enter the following: 

<ContentEncodingParams> 

... 

 <Cluster1> 

  8 

 </Cluster1> 

 <Cluster2> 

  2 

 </Cluster2> 

 <Cluster3> 

  2 

 </Cluster3> 

 <Cluster4> 

  2 
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 </Cluster4> 

 <Cluster5> 

  2 

 </Cluster5> 

</ContentEncodingParams> 

Contents of an ADI File Trigger XML File 
The following is an example of a Sample-ADI-File-Trigger.xml file. For definitions of the 
parameters, see Table 3 – Parameters Defined for Standard XML File-Encoding on page 11. 

<ContentEncodingParams> 

 <InputFile> 

  C:\temp\VoD\Source\Sample.mpg 

 </InputFile>  

  <OutputFile> 

  C:\temp\VoD\Encoded\Sample-enc.mpg 

 </OutputFile>  

  <AdiFile> 

  C:\temp\VoD\ADI\Sample-ADI.XML 

 </AdiFile>  

  <SID> 

  9000 

 </SID>  

  <AssetId> 

  TEST0001137522386093 

 </AssetId>  

  <AssetName> 

  TEST24S04E01_Title 

 </AssetName>  

</ContentEncodingParams> 
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Format of a Tar File Trigger File 
The tar-file trigger file is an XML file that is formatted as follows. All nodes are required 
except for the optional EpisodeId node. For definitions of the parameters, see Table 4 – Tar 
File Parameters on page 12. 

<ContentEncodingParams> 

 <TarFilePath> 

  VoDTestData\SourceTar 

 </TarFilePath> 

 <TarFileName> 

  MyTar.tar 

 </TarFileName> 

 <NewTarFilePath> 

  C:\VoDTestData\EncodedTar 

 </NewTarFilePath> 

 <NewTarFileName> 

  MyTar.tar 

 </NewTarFileName> 

 <SID> 

  9037 

 </SID> 

 <EpisodeId> 

  1 

 </EpisodeId> 

</ContentEncodingParams> 
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Glossary 
A 
ADIFileName 

The name of the CableLabs file (if any) that will be transferred to the Nielsen Data-Collection Facility along with the 
NMR Feed-Point Metadata File. 

ADI-XML File 

The ADI.XML file holds parameters (MPEG file name, asset name, asset ID, episode ID) used in content encoding. In 
tar-file processing, the File Trigger Service extracts a set of encoding parameters from the ADI.XML file before 
starting the encoding session. When the tar-file encoding session ends successfully, the Trigger Service modifies the 
ADI file, updating the MPEG file name and the checksum to correspond to the newly encoded MPEG file. 

AssetId 

The ID of the encoded content. May be derived from an Asset ID field in the CableLabs file. 

AssetName 

The name of the encoded content. May be derived from an Asset Name field in the CableLabs file. 

C 
CF 

Nielsen Collection Facility. 

D 
Decoder 

An application that processes an audio stream (PCM or AC-3) and reports on the Nielsen watermarks (NAES II, NW, 
or both) that it finds in the audio stream. 

E 
Ending TIC 

The value of the last TIC reserved for this asset. 

F 
FD 

Final Distributor. An attribute in watermark that identifies the watermark as inserted by a distributor. 
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FileSizeBytes 

The size of the encoded file in bytes. 

FileSizeSeconds 

The approximate duration (in seconds) of the encoded file. This is just an approximation. For very long files, the 
estimated size may be incorrect by several seconds. 

N 
NAES II (Nielsen Audio Encoding System II) 

Also known as NAES II. The second-generation method of inserting a SID (Nielsen source identifier) and time stamp 
into a TV signal. 

NW (Nielsen Watermarks) 

A Nielsen technology that places an audio watermark in a lower-frequency portion of the active program than does 
NAES II technology. Its lower-frequency position enables NW to be more robust and much less likely to be 
“compressed out” of the program audio by TV distribution providers without interfering with the viewer’s listening 
experience. Unlike NAES II, however, NW code cannot be overwritten by successive program distributors. 

P 
PC (Program Content) 

An attribute in a watermark that identifies the watermark as inserted by a programming source. 

Plink 

Open-source software with a command-line interface that is a component of PuTTY. Plink is installed with the VOD 
encoder. 

PuTTY 

Open-source software used for terminal emulation, transferring network files, and as a serial console. 

S 
Scratch Folder 

The scratch folder must be an empty folder. It is used in processing the tar file specified in the XML trigger file. This 
tar file contains the media content file and an optional ADI XML file. After encoding, encoded media content and the 
optional ADI XML file are packaged into a tar file specified in the XML trigger file. 

SID (Source Identifier) 

Unique identifier that Nielsen assigns to each subscriber (or distribution source) using audio watermarking. Included 
as a component of each watermark, the SID uniquely identifies the distribution source. A subscriber may have more 
than one SID. 

StartingTIC 

The value of the first TIC reserved – and the first TIC inserted into this asset. 
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T 
Tar File 

A file that is collection of multiple other files. A tar file preserves the organization of the files (folders and files) and 
identifying system information including dates and user permissions. 

Tar-File Trigger File 

A trigger file that contains a “TarFilePath” entry. When it detects a tar-file trigger file, the VOD File Trigger Service 
gathers many of its encoding parameters from an ADI XML file contained within the tar file referenced in the trigger 
file. The tar-file trigger file also identifies the SID to be used in encoding. 

TIC (Time in Code) 

A time code used for encoding offline content. See Time Stamp. 

Time Code 

See Time Stamp. 

Time Stamp  

A component of the watermark that identifies one of two attributes: 

• A numeric representation of the date and time at which the watermark was inserted in the stream 
(referred to as a timestamp or time code, and typically used when streaming content is 
watermarked as it is being broadcast). 

• A numeric representation of the time-in-content (referred to as a TIC, and typically used when 
watermarking audio content that is stored in a file). By subtracting the starting TIC from the TIC 
extracted from the watermark, one can determine how many seconds into the stored file the 
watermark is located. 

In NAES II watermarking, the timestamp or TIC is represented as a 32-bit unsigned integer. The timestamp in Nielsen 
watermarking uses only 29 bits. 

Trigger File 

An XML file the presence of which in a specific folder triggers the start of a VOD content encode. The path where 
these trigger files are located is identified by the “EncoderParamFolder” setting in the EncoderConfig.txt file in the 
VOD ROOT / etc folder. 

W 
Watermark 

Used as a noun, also referred to as an audio code, a watermark is a sequence of bits that the Nielsen Watermark 
software inserts periodically in an audio stream. The components of the watermark (SID, timestamp or TIC, and a PC 
or FD flag to identify the point of entry into the flow of content distribution). With these components, a watermark can 
uniquely identify the portion of audio from which the watermark is extracted, that is, the distribution source to which 
the audio content can be credited.  

Used as a verb, the term “to watermark” means to insert Nielsen codes into an audio stream. 
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drive 
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encoded files missing, 51 
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takes too long, 52 
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error 

FTM Transferred 0 files, 60 
no reports over a long period, 60 
SID not in database, 7 
SID/TIC Request Failed, 53 
SidTic Client Failed to Open, 62 
transfer failed, 62 
Unable to establish valid connection with SID/TIC 

Server, 53 
examples 

ADI trigger file, 65 
tar file trigger, 66 
xml trigger file, 64 

failover, 15 
file transfer 

configuring service, 28 
performing, 38 

file transfer manager, 7 
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transferring files with, 38 

file transfers, 8 
file trigger service, 10 

tar files, 12 
transferring files with, 38 

file types 
supported, 16 

firewall, 15 
format 

command line, 36 
formats 

supported file, 16 
installing 

file transfer manager, 20 
SID/TIC server, 19 
VOD Content Encoder application, 18 

layouts, plant, 25 
manually transferring files, 38 
metadata feed-point file, 6 
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metadata files 
transferring, 10 
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files on encoded video tab, 51 
MPEG files on source video tab, 51 
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monitoring (ServicesMonitorTool), 47 
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service 
configuring file trigger service, 28 
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file transfer, 38 
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SID/TIC 
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